Apple Data Detectors User’s Manual

Apple Data Detectors is a new technology that enables your computer to
recognize and then act on certain types of information, or data, in your
documents. For example, if you have aword processing document that
contains several e-mail addresses, Apple Data Detectors can quickly scan the
document, identify all the addresses, and then open a new e-mail message
addressed to the one you select. Or, let's say that someone sends you a World
Wide Web address in an e-mail message You can use Apple Data Detectors to
find the address within the message, then open the Web page in your favorite
Web browser program.

Apple Data Detectors can recognize several different types of data, and soon
software developers will extend the capabilities of Apple Data Detectors even
further. This verson of Apple Data Detectors can identify data that'sin the
form of Internet addresses, which includes the following:

= e-mail addresses

= Web stes

= Newsgroup names

» filenameson FTP (file transfer protocal) sites
= Names of remote computers



For each type of information that Apple Data Detectors identifies, you can
select an action to perform with it. The actions available in this version of
Apple Data Detectors include

addressing a new e-mail message to the selected address

opening a Web browser program and connecting to the selected Web site
bookmarking the selected Web site in a Web browser program

saving a Web document as a file on your hard disk

downloading the selected file from an FTP site

connecting to the selected remote computer

opening a newsgroup with your news reader program

You can customize Apple Data Detectors by selecting which actions appear
for each type of recognized data. You can also turn off actions that require

programs you dorit use See “ Configuring Apple Data Detectors’ later in this
manual for more information.

What's in this manual

Read this manual for information about these topics:

system requirements

installing the software

getting started with Apple Data Detectors
using Apple Data Detectors

configuring Apple Data Detectors
customizing detectors

troubl eshooting

System requirements

To use Apple Data Detectors, you must have the following:
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a computer with a PewerPE processor
Mac OS 76 or later



Installing Apple Data Detectors

To install Apple Data Detectors, follow these steps:

Double-click the Installer icon.

In=taller

Read the information that appears, then click Continue.

In the window that appears, read the software license agreement. If you agree to the
terms, click Agree. Otherwise, click Cancel.

If you click Cancel, you worlt be able to install the software
In the dialog box that appears, click OK.

The dialog box tells you that Apple Data Detectors is going to install actions
that require the use of a variety of application programs If you dorit use a
program, you can turn off the actions that require it using the Apple Data
Detectors control panel. See “Configuring Apple Data Detectors’ in this
manual for instructions.

In the installation dialog box, click Install.
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When the installation is complete, click Restart.
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Getting started with Apple Data Detectors

Apple Data Detectors

Apple Data Detectors works with any Mac OS program in which you can
select, or highlight, text. Apple Data Detectors quickly scans the selected text
for information in specific formats It uses detectors that are programmed to
recognize specific types of information. For example, this verson of Apple
Data Detectors includes several detectors that can recognize Internet
addresses and uniform resource locators (URL ).

Once a detector has identified a piece of information it recognizes, Apple
Data Detectors creates a menu of actions for you to choose from. Actions are
things you can do with the detected information, such as sending it to another
program or saving it for later use The actions that are available depend on the
type of information detected.

This table summarizes the actions supplied with this verson of Apple Data
Detectors:

Type of data Example Actions

e-mail address moof@apple.com send e-mail to address

Web address http://www.apple.com/file.ntml  view Web site, bookmark the site,
or save as document

newsgroup comp.sys.mac read newsgroup

file on an FTP site ftp://apple.com/file.sit download the file

host address research.apple.com connect to the remote computer

Use the Apple Data Detectors control panel to learn more about what the
actions and detectors do. See “ Configuring Apple Data Detectors’ later in this
manual for more information.



Using Apple Data Detectors
To use Apple Data Detectors, follow these steps:
1  Select some text in any application that allows you to highlight text.

Make sure the selected text contains at |east one type of datathat Apple Data
Detectors recognizes. (In this example the selected text contains one
complete Internet address)

|§D§ Note Pad =—F-o9

For additional information, see R‘
Apple's Web site at www.apple.com.
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2 Hold down the Control key, then press and hold down the mouse button.

A “contextual menu’ appears. It lists al the recognized data found in the
selection.
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Tip: If the contextual menu is empty, the text you selected did not contain
any recognizable data.

After the contextual menu appears, you can release the Control key. Be sure to
keep holding down the mouse button or the menu will disappear.
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3 Choose arecognized data item from the contextual menu, then choose an action from
the submenu that appears.
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4 If asked, locate the application associated with the action you selected.

The first time you perform every action, you may need to locate the
application program the action requires. In this example, you are asked to
locate the Microsoft I nternet Explorer 30 program. Use the dialog box to
locate the program on your system, then click Open.
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You must have the requested program installed in order to use the action. If
you are asked for a specific version of a program, just select the version you
have In most cases, the action will still work.

After you locate the program and dick Open, the action takes place
automatically.

6 ' Apple Data Detectors



Apple Data Detectors and large selections

When you select alarge amount of text, it takes more time for Apple Data
Detectors to recognize all the data in the selection. If it takes longer than half
a second to analyze the whole selection, the contextual menu will list only the
data found so far, along with a command called “More Choices”

T . F o E TR T ™
]
| FEEFE (] BEEE @@ G -]

Thanks!

QuickTime far Windoss 2 1.2 changes
L1] Thea inslalle noe Eumes Aubg Fale sdjusiment ofd, 17191 15 siready

tumed on, snd Reguestsd snd Aclusl baok ressonshle (Cresmorable” « “wibhin
| % of each glher™), & lesves seergihing 8= 4 Help

1o [ L [Fuge 17 [ | Wi apple.csm  F

info.apple.oaim ¥

Apple Data Detectors

7



8

Select one action.

If you don't see the data you want in the menu, you can use the More Choices
command to find it. Do the following:

s Choose More Choices from the contextual menu.
Apple Data Detectors completes the analysis of the selected text. A dialog

box appears listing all the detected data in the selected text, and the actions
you can apply to each item of data.
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To apply an action, follow these steps:

In the list of detected items, locate one item that you want to use.

Click the triangle next to the item.

Actions available for the item appear when you dick the triangle
Select one of the actions listed for the item.

Click OK.

The selected action takes place immediately.



Configuring Appl

e Data Detectors

You can control what kinds of data Apple Data Detectors looks for in your

document, and the type of actions that are available to apply to the detected
data. For example you can turn off the detection of e-mail addresses, or you

can turn off the actions that require the use of a specific program.

To configure detectors and actions, use the Apple Data Detectors control

panel. The control panel lists the categories of information that Apple Data

Detectors looks for, the detectors that recognize the format of datain each
category, and the actions you can apply to each recognized item.

To open the Apple Data Detectors control panel, choose Control Panels from

the Apple (&) menu, then choose Apple Data Detectors from the submenu.
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Apple Data Detectors

Learning about detectors, actions, and categories

To learn more about each of the items in the control panel, select an item,
then read the Item Information box. For example, if you dick an action, the
information box tells you what the action does and any application programs
it requires. (You might have to use the arrows to scroll through the text in
order to read al the information.)

Enabling or disabling detectors

You can limit what types of data are detected by turning individual detectors
on or off. For example, if you don't read newsgroups, you can turn off the
newsgroup detector.

= To turn adetector off, click its checkbox to remove the X.

Note: To turn off all the detectors and actions within a category (such as
e-mail), click to remove the X from the checkbox next to the category.

Enabling or disabling actions

You can limit the actions listed in the Apple Data Detectors contextual menu.
For example, if you dorit use Cyberdog to send e-mail, you can turn off the
Cyberdog action for e-mail addresses.

m TO turn an action off, dick its checkbox to remove the X.

Installing new detectors and actions

If you obtain additional detectors or actions, you install them using the Apple
Data Detectors control panel.

To install detectors or actions, follow these steps:

Choose Control Panels from the Apple (&) menu, then choose Apple Data Detectors
from the submenu.

Open the File menu and choose Install.
In the dialog box that appears, locate the new detectors or actions.

Click OK.



5  Wait a moment while the new detectors and actions are added.

The status message in the control panel tells you what Apple Data Detectors
is doing. When the items have been added, the status message indicates that
Apple Data Detectors is ready for use

Removing detectors and actions

If you are certain that you Il never use a detector or action, you can remove it
from the Apple Data Detectors control panel.

1  Click once to select the action or detector you want to remove.
2  Open the File menu and choose Remove.

The selected item isimmediately and permanently deleted.

Tip: Instead of removing actions or detectors, you can disable those you
arent currently using. This way you worit permanently del ete something you
may later want to use

Customizing detectors

Some detectors can be modified to improve their recognition of data. For
example, you can modify the domains that the World Wide Web address
detector can identify.

To modify a customizable detector, follow these steps:

1  Choose Control Panels from the Apple (&) menu, then choose Apple Data Detectors
from the submenu.

2  Choose Show Customizable Detectors from the File menu.

Close W
Install...
Remove
Show Customizable Detectors...
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The Customizable Detectors dialog box appears.
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3 Open the Detector pop-up menu and choose the detector you want to customize.

Tip: Thisversion of Apple Data Detectors has two detectors you can
customize. If you have additional customizable detectors installed, such as
those from a third party, more choices may be available

4  To delete adomain suffix or newsgroup prefix, select it in the list, then press the Delete
key. To add a domain suffix or newsgroup prefix, type it in the list.

= The host detector searches for addresses of remote computers Many of the
common domains are already listed, but you can specify additional
domains (such as“.br” for computersin Brazil) that you want the detector
to recognize

= The newsggroup detector searches for newsgroup names Many of the
popular Usenet hierarchies are already listed, but you can specify
additional newsgroup prefixes (such as “Cyberdog” for Cyberdog topics)
that you want the detector to recognize

Note: Apple Data Detectors considers uppercase and lowercase letters to be

different. For example you should add “.BR,” “.br,” and “.Br” to the list to

ensure proper recognition of host computersin Brazil.
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Troubleshooting

Click Save.

The status message in the control panel tells you what Apple Data Detectors
is doing. When the items have been added, the status message indicates that
Apple Data Detectors is ready for use

The same information appears more than once in the contextual menu.

Thisis normal. Some detectors recognize multiple parts of an address, and
display each part separately. For example, if the selected text contains a
reference to “http://www.applecom/news html,” both the host site
(www.apple.com) and the specific document (www.apple.com/news.html)
will appear in the contextual menu.

An action asks me to locate an application | don’t have.

If an action asks for a specific version of an application, such as Cyberdog 2.0,
try selecting the latest version that you do have. In most cases, the action will
still work.

If you don't have the application youre asked to locate, you cannot use the
action. You can disable actions for programs you dorit have installed so they
won't appear in the contextual menu. See “Enabling or Disabling Actions’
earlier in this manual for more information.

The address | want is always in the More Choices dialog box, or at the bottom of the
contextual menu.

Apple Data Detectors lists the recognized information in the same order it
appears in the selected text. If analyzing the text takes longer than half a
second, the More Choices menu item appears, and you must choose it to
finish the analysis For better results, select less of the text in your document
so the address you want is nearer the top of the list and all of the analysis can
take place at once

Apple Data Detectors
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Apple Data Detectors

The contextual menu doesn't appear.

Make sure that your pointer is positioned over the selected text and that you
hold down the Control key before pressing the mouse button. (Once the menu
appears, you can release the Control key,)

Make sure you continue to hold down the mouse button after the menu
appears. When you rel ease the button, the menu disappears.

Check the status message in the Apple Data Detectors control panel. Apple
Data Detectors carit be used while detectors and actions are being compiled.

Make sure Apple Data Detectors is properly installed. Use Extensions
Manager to make sure that the Apple Data Detectors control panel and the
Text Encoding Converter, Apple Data Detectors Extension, SOM Objects for
Mac OS, Contextual Menu Enabler, and Contextual Menu Extension are all
turned on. Then restart your computer.

If you continue to experience problems, reinstall Apple Data Detectors.
Every time | select an action, I'm asked to locate a program.

The first time you use each action you must locate the application program
that the action requires. For example, the first time you use the action “Open
in Cyberdog,” you must locate the Cyberdog application. Also, the first time
you use “Send e-mail using Cyberdog,” you must locate the Cyberdog
application, and so on until you have used each action at least once If you
later move or rename the application, or reinstall the actions, you may again
be asked to locate applications for the actions.

Actions that require Claris Emailer don’t work.

If Emailer is configured to display the Connect Now dialog box automatically
when Emailer opens, the actions will not be completed. You should turn off
the Connect Using option in the Emailer preference settings

Actions that require Fetch don’t work.

If Fetch is configured to display the New Connection dialog box automatically
when Fetch opens, the actions will not be completed. You should turn off the
Show Sign-on Dialog At Startup option in the Fetch preferences.



The Help menu item is unavailable.

The Help menu item in the contextual menu provides help for the application
in which youve highlighted the text. For help using Apple Data Detectors,
refer to this manual.

Apple Data Detectors doesn't recognize a valid Internet address.

Make sure that you highlight the entire address before invoking Apple Data
Detectors

Make sure the host domain (or newsgroup prefix, if applicable) islisted in the
detector's configuration. See “ Customizing Detectors’ earlier in this manual
for more information.

Apple Data Detectors considers uppercase and lowercase letters to be
different. If adomain or newsgroup prefix isin mixed-case (“.COmM’") it may
not be recognized unless you customize the detector. See “ Customizing
Detectors’ for more information.

Apple Data Detectors replaces the contents of the Clipboard.

If an application program doesnt directly support the contextual menu, the
Contextual Menu Enabler copies the selected text to the Clipboard and then
invokes Apple Data Detectors. Any information you had on the Clipboard is
replaced by the selected text. If an application supports the contextual menu,
this won't occur.
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